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 Screencasting with Camtasia Studio 

What is a Screencast? 
While a screenshot is a still picture of a computer screen, a screencast is a recording of a screen over 
time, often with accompanying narration, that is distributed, typically, online.  

Screencasts are popular for capturing PowerPoint presentations, creating tutorials on how to use software, 
and for demonstrating how to locate resources on the Web.  

Camtasia Studio is one of several tools for creating screencasts available for Microsoft Windows. In our 
experience, Camtasia Studio is the product of choice for capturing lectures, whereas Adobe Captivate 
may be a better choice if you primarily create training and demos of software.    

Instructors can either record “live,” in a classroom or lecture hall, or record in the privacy of their office.   

Screencasting is frequently combined with “inking” technology, for instance using aTablet PC, to 
annotate PowerPoint slides.  
 

What Do I Need to Create a Screencast?  
Camtasia Studio provides the software for recording, editing and publishing screencasts.   

In addition to Camtasia you will need 

• A microphone to record narration.  

• A webcam to record video of the narrator/presenter that can appear in a corner of the screencast 
window. 

• A way to share your screencast movie, such as a SPARK site, a UDrive account, a blog, or 
another sort of Web site. Screencast movies can also be distributed on DVD, if  needed. 
 

Two Ways to Create Screencasts in Camtasia Studio 
Camtasia Studio provides two primary methods for recording screencasts; you can record any area of the 
screen and any activity that takes place in that area, or you can record within PowerPoint. 

Screen recording 
The default method records all activity on the screen, or a selected area of the screen. You can record 
either within a single application, or across any software in use.  

This is the preferred method for creating screencasts of most computer activities such as software 
demonstration or guide to finding resources on a website. (See page 4.) 
 

PowerPoint Add-in 
Camtasia Studio includes a PowerPoint Add-in that facilitates creating screencasts of PowerPoint 
presentations. This is the preferred method for capturing screencasts of PowerPoint presentations, as long 
as the presentation does not include links that take you out of PowerPoint, for instance, if your 
presentation has a link that opens a Web page in a Web Browser . (See page 8.) 
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 Screencasting Process Overview 
 There are three distinct steps to creating a screencast in Camtasia is, with different file types for each 
step. 

1. Record 
     The first step is to create your recording in Camtasia; this creates a .camrec  file.   

2. Edit 
To edit your recording, open the .camrec file in Camtasia Studio,  
 then save the project in the editable .camproj format.        

3. Produce & Share 
Finally, before you share your screencast, 
it must be exported to a file format that can be     
posted to the web or burned on a CD.  
 
When you publish for the Web (to upload to 
SPARK, a blog, or UDrive, Camtasia produces 
a group of files in a folder.  Make sure to upload 
all the files to your Web site.  Though the main 
movie is the .mp4 file, you should link to the 
.html file.   
 
If you publish to YouTube or TechSmith’s hosting service (screencast.com), Camtasia will not save 
local files, but will upload video to be hosted by the service. 

Before you Start  

Prepare your narration 
It is useful to have an outline or notes to work from when recording narration for a screencast. Depending 
on your needs and personal style, a well-organized outline may be as useful as a detailed script in 
ensuring that you cover the relevant material and still sound natural and engaging.    

Set up your computer screen and recording environment 
Do you need to record the entire computer screen, including application menus, or just the inside of a 
document window or browser window?  Will your computer’s desktop show in the demo?  Do you need 
to clean it up?  

Are you recording a software or Web site demo?  If so, avoid custom settings or add-ons in your 
application or browser that your audience may not have on their own computers.    

Don’t forget to silence your cell phone, close the door if you are recording in your office,  turn off fans or 
other background noise. 

Check your recording hardware 
There’s nothing worse than going to start your lecture only to discover your audio/video hardware is not 
connected. 

• Make sure your microphone is plugged in to your computer. 

• If you will record video, make sure your camera is plugged in to your computer. 

Upload all the files to SPARK, your blog, or Web site. Link to the HTML file. 
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 Record the Screen with the Camtasia Recorder 
Set up the recording 

1. Arrange the open application windows to show what will be onscreen at the beginning of your 
recording. 

2. Launch Camtasia Studio. The first time Camtasia Studio opens, a Getting Started project appears. 
Go to File > New Project to close the Getting Started project and begin a new one. You do not 
want to record into the Getting Started demonstration project! 
After the first time you use Camtasia, only the Welcome Screen will open. 

3. On the Welcome Screen, or, if Camtasia is already open, from the Camtasia Studio Task Bar  
(at top), click Record the Screen,. 
  
  
  

The Welcome Screen provides an easy way to get 
started with the different ways of creating 
screencasts, such as recording the screen, creating 
a PowerPoint recording, or importing images for a 
slide show (Import Media).  

  
  
  
  
 
  

4.  
  
 
The Camtasia Recorder window will open.  

5. In the Camtasia Recorder window: 

a. Select the area of the screen to record:  
To record the entire screen, click Full Screen.  
To record a selected are of the screen use the Dimensions pop-out to choose a preset 
size, either Wide Screen or Standard aspect ratio (proportions). 
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 Tip: This step sets the dimensions for the recording area.  Later, after you are done 
recording and you go to produce your actual movie, you can reduce the dimensions for 
the produced movie. Depending on the level of detail you need in your final movie, 
scaling down a large capture area may make details such as small text difficult to see. 
When you go to produce the movie, you may want to employ Camtasia’s zoom-n-pan 
feature, which temporarily magnifies the areas of the screen where you clicked or typed 
while recording.  

Because you are not recording yet, you can still fine-tune the capture area. You can: 
     -  Rearrange the windows on the screen to fit inside the capture area 
     -  Relocate the capture area by dragging  the crosshairs at its center 
     -  Enlarge or reduce the capture area by dragging a handle at its edge.   

b. Select and adjust video input devices: 
To choose whether to include video in your recording click the Webcam button to toggle 
video on and off the camera (by default,  camera input  is set to off).   
 
Use the camera pop-out menu to select the video source (for example, a built in Webcam, 
or a camera you have attached to your computer to record, for instance a lecture hall).   
  
  
  
  
  
  
  
  
  
  
  
  
  
  
 

c. Select and adjust audio input devices: 
To choose whether to record narration along with the screen, click the Audio button to 
toggle on and off any mic connected to your computer (by default, audio is set to on.) 
 
Use the audio pop-out menu to select your audio source.  A portable mic or headset may 
not be automatically recognized by your computer-- you may need to select it from the 
audio menu. 
 
 
 
 
 
 
 

 

When the camera is on, a preview image 
will display if you roll the cursor over the 
tiny thumbnail next to the camera button. 
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Perform an audio test by speaking into the mic:  
You should see a fluctuating green-to-yellow bar under the Audio Input slider.  
     - If the color under the slider is orange-to-red, slide the volume control to the left  
        to lower the volume. 
 
 
 
 
 
 
 
     - If you do not see any fluctuating color under the Audio Input slider: 
                 1.  Check that your mic is plugged in.  
                 2.  Confirm in the audio pop-out menu that your mic is selected. 
                 3.  If audio input is still not registering, open your computer’s  
                      system Control Panel and go to Sound, then Recording and select your mic. 

Make and Save the recording 
1. When you are ready to begin recording, click the large, red rec button (or hotkey F9).   

TIP: Count to 5 before you start to speak or navigate around the screen; this will avoid clipping off 
the beginning of your presentation. 

2. When recording starts, a video-style controller will appear.  

  
 

- To pause recording click the Pause button (or F9).   
- To resume recording, click the Resume button (or F9) again.  

 
3. When you have finished recording, click the Stop button on the recording controller (or hotkey F10). 

Camtasia Studio will generate a preview of the screencast in the Camtasia Recorder Preview window. 

4. Under the preview window is a 
playback controller, and buttons to 
save or delete the recording. 
 
You can choose to produce the 
recording straight to a shareable 
format, but  we recommend instead 
that you save the recording so that it 
can be edited in Camtasia Studio. 

Click Save & Edit. A Save dialog 
box will open. 
 

Audio Input Test 
When you speak, you should 
see a fluctuating green bar 
here. 

Use the slider to adjust the 
volume 
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 5. Choose a filename and a location to save the file.  

Note: By default, files will be saved in MyDocuments in the Camtasia Studio folder (or the last 
location where you saved Camtasia files).   

You can change the location, but regardless, we suggest you create a new folder in which to store the 
files for each project. 

The file will have a .camrec extension (e.g., myscreecast.camrec).  

Click Save. Camtasia Studio will open and the Editing Dimensions dialog box will ask what size to 
make the produced video. 

6. In the Editing Dimensions dialog, pop-out the 
Dimensions drop down to select the best size for your 
use.    
TIP: Automatic is a good general-purpose choice for 
posting videos on the Web.  It will avoid the black 
borders that can appear if you choose a preset where the 
aspect ratio doesn’t  match the aspect ratio of your 
recording. 

If you need to produce both a Web and a CD version of 
your movie, choose the larger dimensions here.  Later 
when you produce your sharable files, you have another 
chance to choose a different movie size.  At that point 
you will only want to scale down, not scale up, the 
movies. 

Choose your dimensions and click OK. 

After a few seconds delay, your recording will open in 
Camtasia Studio, with the screen capture, audio, and  
web cam video (if you recorded it) each in it’s own track on the timeline. 

In the preview window, if you used the Webcam feature, the video will appear to bottom-right of the 
screen recording. You can change the position of the Web cam video later (see page  

7. Go to File  > Save Project to save the project as an editable .camproj file. 

 

To learn how to edit and produce your project, go to page 10-- Edit Your Recording. 
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 Record with the Camtasia PowerPoint Add-In 
TIP: The PowerPoint Add-In is only useful if your entire presentation takes place within PowerPoint. If 
your presentation includes hyperlinks to Web pages or other applications, use the Record Screen method. 

Prepare PowerPoint Presentations for Screencasting 

Visual Design for Screencasting 
Screencasts of PowerPoint will be improved by facilitating the readability of your PowerPoint slides: 

 

PowerPoint features that Camtasia can use 

• Presenter Notes for PowerPoint slides can be imported into your screencasts as captions. 
Importing notes improves accessibility for all audiences. 

• Slide Titles can be used by Camtasia to create a table of contents for your screencast.  

Recording the Presentation 
You may wish to print out notes or an outline for your PowerPoint slideshow in preparation for recording 
a screencast of your slides.  

1. Launch PowerPoint.  Note: The first time you use PowerPoint with the Camtasia Add-In enabled, you 
will see a welcome screen inviting you to view a 3 minute introductory screencast on getting started 
with the Add-In. On subsequent uses this screen will not appear. 

You can also initiate a Camtasia PowerPoint recording from the Camtasia Studio Welcome screen, or 
from a new Camtasia project, in which case PowerPoint will launch and ask you to locate your 
PowerPoint presentation file. 

2. In PowerPoint, click the Add-Ins tab. 
 
 
 
 
 
 
 A series of recording buttons for Camtasia should appear at the left side of the PowerPoint ribbon. 

3. Click the Recording Options button. For Audio Source select your mic. Perform a sound check by 
speaking into your mic. You should see a fluctuating green bar. Adjust the volume as needed (the 
colored bar should stay in the green-to-yellow range, and should not go into the orange-to-red range).   

Troubleshooting: If audio does not register, go to your System Control Panels, and to the Sound 
settings and confirm your Mic is selected for audio input.  

Recording options 

Add Ins Tab 

• Use large type (32pt for example).  
Your screencast movie will be much smaller than 
the full screen presentation. 

• Use Sans serif fonts. (Arial, Verdana, Tahoma, etc.) 

• Use high contrast text and background combination 

• Use a simple backgrounds with minimal 
texture (this will also reduce file sizes) 

• Minimize use of slide transitions 
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 To capture both microphone and system audio, for instance if your presentation includes 
embedded audio or video, on the Add-Ins tab under Recording Options, check Record System 
Audio.  
Note: Some soundcards, and versions of Windows prior to Windows 7, may not accommodate 
recording both mic and system audio.  For a troubleshooting guide and work-arounds see: 
http:/www.techsmith.com/learn/camtasia/6/faq/system-audio.asp 

To record video from a Web cam, under Picture in Picture check Record from camera. 
 
Important: Click OK before leaving the Recording Options window. 
 

4. Click Record.   
  
PowerPoint will launch in presentation mode, overlaid by a box saying 
Camtasia Recording is paused. You have one more chance for a sound-
check here. 

5. Click Click to Begin Recording. 

You may see a warning screen.  

 

Because PowerPoint presentation mode is full-screened, it commands a lot of computing resources to 
record.   Click Close to cancel the warning and attempt to record your presentation.  If your computer 
is performing poorly, follow the suggestions in the tip to improve performance.  

6. Advance through the PowerPoint slides as normal, narrating into the microphone. 
To pause/resume recording: press CNTRL + SHIFT + F9 on your keyboard.   

7. At any time press the ESC key (or CNTRL + SHIFT F10) on your keyboard to exit the presentation 
and stop recording. Or, when you reach the end of the presentation, Camtasia will give you the option 
to Stop recording. 

8. You will be prompted to choose a filename and a location to save your recording as a .camrec file. 

9. Choose to either Edit in Camtasia, or Publish without editing. 

10. Camtasia will ask if you wish to Include Notes. This is recommended for universal accessibility (see 
tips below for Closed Caption controls). When editing you can setup the captions to appear only if the 
user clicks a CC button (see Editin section of this handout). 
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 11. The Editing Dimensions dialog will open.  Pop-out the 
Dimensions drop down to select the best size for your use.   
  
TIP: Automatic is a good general-purpose choice for posting 
videos on the Web.  It will avoid the black borders that can 
appear if you choose a preset where the aspect ratio doesn’t  
match the aspect ratio of your recording. 

If you need to produce both a Web and a CD version of your 
movie, choose the larger dimensions here.  Later when you 
produce your sharable files, you have another chance to 
choose a different movie size.  At that point you will only 
want to scale down, not scale up, the movies. 

Choose your dimensions and click OK. 

After a few seconds delay, your recording will open in 
Camtasia Studio, with the screen capture, audio, and if you 
recorded it, video--each in their own tracks on the timeline. 

 
If you used the Webcam feature, the video will appear to bottom-right of the presentation.



Screencasting with Camtasia Studio 7 

 
OIT Academic Computing, University of Massachusetts       http://www.oit.umass.edu/academic           100607mt 
  

11 

oit 

 Edit Your Recording 
Why edit? At minimum, you may want to trim off the beginning and end of your screencast. 

Camtasia Studio also lets you combine recordings, overdub audio, add titles, and create effects such as 
transitions between segments 

Main Interface  
After recording, if you choose to Edit, or, if you open a .camrec, or .camproj file from your desktop, 
you’ll be taken to Camtasia Studio, where you’ll edit and produce your recording. Once an editing project 
is underway, save a working copy as a .camproj file. When you are finished editing, you’ll export a 
sharable movie file to post online or burn to a CD. 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
Note: Editing material on the timeline, does not affect corresponding clips in the bin. Clips in the Clip 
Bin maintain the original recording. If you need to start over you can delete everything from the timeline 
and drag now a new instance of your recording. 

Timeline & Tracks  
On the timeline you can cut recordings into clips, 
delete sections, rearrange sections, and control when 
to add effects. 
Each kind of content (audio, video, call outs, captions, 
markers, transitions, etc.) is on its own horizontal track 
in the timeline. 

Preview window 
Shows a preview of your screencast. 

Workflow steps 
 Record, Import, Produce. 
 

Task tabs &  
Editing options 
Click the tabs below to select a 
task.   
This area will display the 
options available for each task.  
 
 
 

Preview controller 
 

Timeline playhead & 
In and out points 

• Gray, center slider shows location in movie. 
• Green, left slider marks in point, and red, right 

marker marks out point. 
• Highlighted blue area between markers is 

selected to edit (cut, copy, process audio, etc.). 
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 Opening Files for Editing 

Immediately after recording… 
1. When you choose to edit at the end of a recording session, you’ll be sent directly into the editing 

mode in Camtasia Studio. Camtasia will automatically place the recording in the timeline, and 
you’ll be asked to choose a project size (see above). 

2. Save the project as a .camproj. 
 

Open or import a saved .camrec file 
1. You can open a saved .camrec recording at any time:  

• Double-click on a .camrec from the desktop and Camtasia will launch. The recording will be 
placed in the timeline, and you’ll be asked to choose a project size (see above). 

• Or, if you Launch Camtasia, skip past the Welcome screen, and go to File > New Project, 
then click the Import Media button on the Workflow bar. Locate and open the .camrec file. 
The recording will be placed in the timeline, and you’ll be asked to choose a project size (as 
above). 

2. Save the project as a .camproj. 
 

Open a saved .camproj Project 
To continue editing  a project you have already saved, double-click on a .camproj file from the desktop, 
or launch Camtasia, skip past the Welcome screen, and go to File > Open Project. 

 

IMPORTANT!  For each project, keep .camrec and .camproj files in the same folder! 
In order for a .camproj file to open, you must keep the .camrec files used in the project in the same folder.  
If you move the .camproj file or any of the .camrec files out of the folder into which you first saved them, 
or make a copy of just a .camproj file and move it out of the folder without also copying the .camrec(s) to 
the same place, you will not be able to open the project for editing. 

Note: Your final product will be a .mp4, or other sharable movie file. These cannot be edited in Camtasia. 
To make changes to a movie you will have to start from scratch with the .camrec recording or reopen the 
.camproj project, then export (produce) the movie again.  
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 Basic Editing 

Trim off the beginning or end of a recording 
Here’s a convenient method for removing unwanted frames from the beginning or end of a lecture:  

1. Position the mouse in the Video track, at the very beginning or 
end of the video track: you should see a double- arrow cursor. 

 

2. Hold down the mouse button and drag the cursor on the video 
track of the timeline (the cursor will change to look like inset 
boxes.  

3. When you release the mouse, the material before the cursor (if 
editing the beginning of the recording) or after the cursor (if 
editing the end of the recording), will be removed and the entire timeline will snap back to the 
0:00:00. 

Insert Markers 
Before you make edits to a recording, it can be helpful to play through the video and mark the locations 
on the timeline where you will make a cut, adjust the audio, insert a title slide, etc.  

Note: Recordings made with the PowerPoint add-in arrive in Camtasia studio with a marker between each 
slide. 

1. Use the Preview Controller to play the recording. 
 

 
 
 
To fine tune your location in the timeline use the frame-by-frame playback buttons on the Preview 
controller.    

2. As the Preview playhead reaches each place you will make an edit, 
press M to insert a Marker in the timeline. 

3. Name the marker with a short but informative name. 
4. Click on a Marker in the Timeline to move the playhead to  

that location, and then make your edit.  
Note: Markers are associated with a time on the timeline –  
not a frame in the video.  

 
Advanced Tip:  You can also add a Marker while recording by 
pressing CTRL+SHIFT+M. 
 
 
 
 

Preview Playhead location 
 

Frame-by-frame playback 
 

Rewind 
 

Timeline Playbar 
 

Roll over marker for 
name and time-stamp. 
 

Timeline Marker 
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 Select a section of the timeline to edit 
1. Click in the Time Ruler, or on a Marker, at the top of the Timeline  

where you want the selection to begin. The playhead will move to that 
location. 

2. Drag the Out point slider through the Time Ruler, releasing where you 
want the selection to end. (It will snap to Markers) 
The area between the green In point and the Red out point will be 
highlighted (and selected). 

3. To fine-tune your selection, drag the In or Out markers. 
4. You can now edit the selection (cut, copy, adjust volume, edit Smart Focus, etc.)  

Split into clips 
Splitting a track into segments, or “clips,” lets you to add title slides within the movie, add transitions 
between segments, or delete a clip.   

1. Click in the Time Ruler, or on a Marker, at the top of the timeline, or 
use the Preview controller to move the play head to the spot where you 
wish to make a division.  

2. In the toolbar above the timeline, click the Split button, or press S on 
the keyboard.  
You see a vertical line across all the tracks in the timeline oce the split 
is made; 

Note: If you split the timeline while a selection is made, the split will 
be made at the Out marker. 

Delete a clip from the timeline 
Once a recording is split into clips, you can delete sections. 

1. Right-click on a clip in the video track of the timeline and choose “Remove From Timeline.” (Audio for 
that clip will also be removed.) 
The movie content will snap closed to remove the time gap. 

Add titles to your presentation  
To add a title clip to the beginning or end of your movie or between any clips:  

1. Click the Title Clip tab above the 
timeline. The Title Clip panel will 
open. 

2. In the Title Clip panel, click Add 
Title Clip. The screen will change 
to show a text editor in the Title 
Clip panel, and a Preview of the 
clip in the Preview area.  

3. Enter the desired text in the entry 
box . A preview of the slide will 
show to the right. 

4. Format the text size and font, and adjust the background color as needed.  

In point 
 

Selected footage 
 

Out point 
 

Split button 
 

Preview 
Window  w 

Type title 
here 
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 5. When you leave the Title Clip panel, the title clip will be placed in your Clip Bin (first Task tab).   
To add the title to the movie, drag it from the Clip Bin and drop it  
between the clips on the timeline where you want it to appear. 
 

Add transitions between clips 
6. Click the Transitions tab. (If the 

tab doesn’t show, click the More 
tab and choose Transitions.) The 
Transitions window will open and 
the timeline will change to 
“storyboard” mode. 

7. To apply a transition, drag-and-
drop its icon onto an arrow 
between clips. (Clips must be split, 
not just marked.) 

8. To continue editing, click another 
tab. 
 

Apply SmartFocus 
While you are recording the screen, 
Camtasia tracks the location of every mouse click and keyboard entry.  When SmartFocus is applied to a 
clip on the timeline in Camtasia Studio, the movie will zoom in to wherever mouse or keyboard activity 
was tracked. This can make menus and text entry boxes or details of an image easier to see when the 
produced movie will be smaller in dimensions that the recorded clip.  

1. Click the Zoom-n-Pan tab. (If the tab doesn’t show, click the More tab and choose Zoom-n-Pan.)  
2. To apply SmartFocus to the entire timeline, click Apply SmartFocus to Timeline, or to apply it to 

just a segment of the timeline, make splits (see above), then click Apply SmartFocus to Clip.  
 
To manually adjust the position of the zoom area, the magnification of the zoom, or it’s duration,  
click on a zoom-n-pan key frame in the timeline.  You can then reposition or resize the zoom box in  
the preview in the Zoom-n-Pan tab.  You can also edit values for duration of the zoom. 
 

Work with Captions 
If you used the PowerPoint add-in  
and included Notes when you brought your recording into 
Camtasia Studio, The notes text will display, at a relatively 
large font size over the bottom third of each slide.  

To make your published recordings so that your viewers 
can turn closed captioning on and off by clicking a small 
CC in the movie’s controller: 

1. Click the Captions tab. If the tab doesn’t show, click 
the More tab and choose Captions. The Captions 
window will open 
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 2. You will see a useful tip for adjusting the timing on the captions to match events on screen. For now, 
close the tip window.  You can return to this later. 

3. Use the In and Out sliders to select the entire timeline. 
4. At the top of the Captions panel click Overlay and Display.   

When the movie is published in it’s sharable format, there will be a CC button  in the controller.  By 
default caption will be off, but those who wish to view captions can click to button to make them 
show. 
 
 

 
For more on captioning in Camtasia search the Learning Center help pages at techsmith.com. 
 

Edit Audio 
1. Click the Audio tab. If the tab doesn’t show, click the More tab and choose Audio. 
2. The Audio options will appear.  

Note: Global settings such as noise reduction are applied to the entire timeline, while the Editing 
tools are applied to a selected section of the timeline.  

 
3. To edit a section of audio you must first select the segment in the timeline (see above). 
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 You may find it helpful to zoom in on the timeline to position the In and Out sliders for the selected 
section of the timeline. 
Editing tool options include increasing & decreasing volume, and fading in and out (useful to ease in 
or out a music track, for instance at the beginning or end of a project. 
 
The Silence button is especially useful. This can be used to 
remove audio from a section of the timeline without removing 
the corresponding screen recording. 

4. To add an additional track of audio for background music or 
overdubbing, use the Import Media button at the top of the 
editing screen. Drag the media clip onto the timeline, a second 
audio track will automatically appear. 

 
Save the project file 
1. Go to File > Save.   
2. Choose a filename and a location to save the file.  The file will have a .camproj extension.  Return to 

the .camproj file for further editing as needed. 
 

Combine recordings in a project 
You can add a Camtasia recording, an audio recording, or a video recording to a Camtasia Project. 

1.  Click Import Media (at top) and browse for the CAMREC, MP3 or other allowable file type.   

2.  The recording will appear as a clip in your projects Clip Bin.  Drag the clip onto the timeline. 
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Export Your Screencast  
The export or publishing process, called producing in Camtasia Studio, assembles your screen recording, 
narration, and effects into a final product that can be delivered to your students. At this point you can 
choose from presets, or customize your settings.  

1. Select an action from the Produce & Share menu: 
  

  
  
  
  
 
 

2.  You can publish online directly to the Screencast.com or YouTube services.  In this case no local 
files will be saved to your computer: Your files will be stored online only 
If you Choose Produce and share, you’ll need to 
select a Production Preset.  
Production settings will default to what you chose 
when you opened the project, but you can choose 
a different preset, or customize your settings at 
this point.  

3. Choose a location to save the file(s). 
4. Camtasia Studio will begin to “render” the final 

product.  
 
 
Note: The rendering process is slow: generally 
at least as long as the video.   
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Share Your Screencast  
Depending on your export settings producing your screencast may result in a folder of files (as with .mp4 
or .swf files) or a single video file (.avi).  

IMPORTANT! When working with a folder make sure to always keep the files together in their 
folder. 
 

Posting a Screencast in SPARK 
You can share your screencast with students via SPARK by uploading your files via the SPARK file 
manager. If your screencast is a folder of files you may find it easiest to zip the folder before uploading it, 
then using SPARK’s file manager tool to unzip the folder.  

Once the files are uploaded (and unzipped), create a link to the .html file in the folder to make the 
screencast available to your students.   

For more on posting content in SPARK see our “Managing Files and Course Content in SPARK” 
handout, located on the SPARK faculty support site:  http://www.oit.umass.edu/webct/campus-
vista/faculty/tutorials/ ) 
 

Post a Screencasts on UDrive 
If you don’t use SPARK, OIT’s UDrive is a good place to host files for sharing, either with specific 
members of the UMass community, such as students or colleagues, or with the public.  For more on using 
UDrive visit the OIT help pages at http://www.oit.umass.edu/udrive/index.html. 
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 Appendix 1: Draw on the Screen while Recording    
Camtasia Studio includes a feature called ScreenDraw that allows you to add notes and drawings to the 
screen while recording. Most instructors who are serious about “inking” use dedicated technology such as 
a SchoolPad or Tablet PC rather than this tool. 

Note: You cannot remove annotations from the saved 
recording, so plan accordingly. Unless you are 
recording a live lecture, you may prefer to add 
annotations in Camtasia Studio while editing. 

See the Camtasia online help for step by step 
instructions for using Screen Draw. 

 

 

 

Appendix 2: Video File Formats (adapted from Camtasia help) 

MP4  is the default format for quick Web publishing in Camtasia.  It is a versatile format that plays on 
Macs & Windows and most media players and devices, including smart phones and is the current 
standard for delivering multimedia. 

SWF movies run in the nearly ubiquitous Flash Player. We say nearly, because currently Apple products such as 
iPhones and iPads will not play Flash SWFS.  The SWF format is best for short, low motion videos (most screen-
captures and basic PowerPoint slides). Avoid SWF if your screen capture includes camera video.   

FLV, like SWF, plays on both Mac & Windows, in the nearly ubiquitous Flash Player.  FLV’s will not play on 
Apple iPhones or iPads. FLV is currently the default format for YouTube. It’s a  good cross-platform alternative to 
lossy or compressed video formats such as WMV or MPG.  Using FLV for long, high motion videos may result in a 
choppy movie, but a smaller file size.   

WMV (Windows Media Video) produces a video that plays in Windows Media Player.  

MOV (QuickTime) produces a video that plays on both Mac and Windows in the Apple QuickTime Player.  

AVI  (Audio Video Interleave) is used for CD-ROM and DVD distribution. AVI retains the highest quality. 
Many video-editing programs can edit AVI files. Warning: AVI produces very large files, not suitable for 
posting on the Web!  

M4V (iPod/iTunes) is best for playback on an iPod or in iTunes.  

MP3 (Audio) when saved as MP3, Camtasia pulls an audio-only file from the audio on the Camtasia Timeline.  
MP3 is a standard format that plays back in numerous players; compatibility is not an issue. 

RM (RealMedia)  RM produces a video for playback in RealPlayer.  

CAMV (Camtasia for RealPlayer) Requires a RealServer for streaming and requires a browser plugin. 
Best for low motion, with few color gradients, such a simple bulleted text PowerPoint presentations. 

Animated GIF can be used to make short animations that will play back in any browser, on any computer, or to 
add short animations to a PowerPoint presentation.  
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 Appendix 3:Production & Publishing Best Practices 
 
Use the same stylistic conventions for all the videos in a set 
Use standard practices for each set of movies published on the same Web site or CD (similar title screens, 
closing screens, consistent recording of keyboard sounds, etc.). 

Movie length 
Several short “bite-sized” movies are often better than one long movie, especially if you are producing 
demos rather than capturing lectures. 

File size 
Depending on the contents of your screencast, you might be able to reduce the file size of your published 
movie by using a different Production Setting. You may need to experiment and compare, for instance: 

• Movies containing full motion video may have with a smaller file size if published as FLVs. 
• Simple PowerPoint slides with an audio track may have with a smaller file size if published as 

SWFs. 
 

On the Web page that links to the movie… 
To help your audience to decide when and where to watch the movie:  

• Indicate the movie length (in minutes). 

• Indicate if the movie has an audio track. Your audience may want to use earphones, or turn on 
their speakers.  

On the title screen of the movie… 
• Indicate the movie length in minutes on the title screen. 

• Indicate (in text) if the movie has an audio track. Your audience may want to use earphones, or 
turn on their speakers.  
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